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1 General Information

Connect+ is an enterprise management software designed
to monitor your store or region’s performance in real-
time. Currently, Connect+ supports the following Emerson * Advisory: Alarm/Notice generated from Controller,
Controllers: E2, Site Supervisor, and Dixell. or notification from Connect+.

1.1 Terminology

This guide provides a step-by-step guide for Store * Activity: A job that users conduct to access

Managers or Monitoring Technicians on how to use controllers.

Connect+ to monitor your stores or regions. The following * GS Screen: Graphical Status Screen. For example,

topics are included in this user guide: Floor Plans or Summary Screens for real-time store
monitoring.

How to use an Advisory Map to locate your
problematic sites

How to locate sites that are not sending alarms
How to diagnose advisories
How to review Live Advisories from Controllers

How to monitor stores in real time and compare
store/device performance

How to search a Site, a Controller, or a Device in
your enterprise

Review Enterprise Summary including Stores,
Controllers and Devices information

How to export store data

Nav Frame: A tree frame located on the left side of
the screen.

List Power Builder: Tool for creating Watch/Graph
Points list.



2 Logging in to Connect+

2.1 LoglIn

Before logging into Connect+, contact your Manager or IT
Department to obtain your Connect+ Login credentials.

PROACT

Upon your first login to Connect+, you will be asked to
change your password. Please enter the generic password
you received as your Current Password. Select a password
with no less than 8 characters.

Reset Your Password |

Connect+

PROACT

If you have forgotten your Password or Login ID, click Forget
Password or Forgot Login ID. You must have a valid email
in your user profile with Connect+ in order to receive the
temporary password or Login ID.

2.2 Navigate Connect+

Once logged in, you will see that Connect+ Ul is designed
with four areas:

* Area 1 contains main toolbar icons for access to
the Enterprise Level Information, such as Alarms,
Sites without Alarm Connection, Store/Device
Summary, Schedule Jobs, Global Search, and more.

* Area2is the Navigation Tree, which is set by your
Administrator to reflect your Enterprise Hierarchy.
The navigation tree starts from the Directory level,
which reflects the Region or Banner you belong
to, then your Sites that reflect your Stores. Under
each store, you can review the Controllers installed,
down to the Devices the

When you right-click on each level in the Navigation Tree,
you will see the Right-Click Menu, which is provided

to review information or perform activities to access
controllers.

* Area3is the Context Menu, which is associated
with your Navigation Tree level. The Context Menu
is same as the Tree Right-Click Menu.

* Area4isthe major Review area. When you click
the Enterprise Toolbar, Navigation Tree,
Right Click-Menu, or Context Menu, the
information or Controller Activity progress/result is
displayed in this area.

2.2.1 Connect+ Enterprise Toolbar Navigation

Total Sites )
without ~ Enterprise Multi-Language
connection  Summary

Alarm Icon with
Total Active
Alarm Number

Search bar for Directories, Sites,
Control Systems, Users,
Hide Nave Service Providers, and mol




Alarm

Sites without Connection

Homepage

Enterprise Summary

Count indicates the Total Number of Active Alarms in the Past 24 Hours. Users will be directed to
View Advisories upon clicking.

Count indicates the Total Number of Sites without Connection in the Past 24 Hours. Users will be
directed to Connection Verification Report upon clicking.

Users will be directed to their own Connect+ Homepage once the preference is set.

Check Region, Site, Controller, and Device Information.

Access to List Power Builder and Schedule Manager to:

Header Menu

e Create preferred Device Attribute List to monitor

* Schedule different activities to execute jobs on Controllers

Language Setting

Global Search Points.

2.2.2 Store Hierarchy by Navigation Tree

From the Navigation Tree of the Connect+ landing page
interface, a Store Hierarchy is reflected by the Tree listed
with the concept of Directory, Site, Control System, Unit,
Application Type, Application, and Point.

Refresh Filter Clear
Nav Tree Points Check-box

Watch or
Graph Points
Jime
=] E
2 uSG) Segapsre
afe
& [ Roe-300 81 E2 wnivan
Navigation Tree
Directory

Directory is a region or a banner of a customer. Connect+
offers a sub directory under the parent directory to reflect
the user’s own organization structure.

Sites

Sites are stores in the customer’s organization. One site
belongs to only one Directory.

Control System

A control system is a set of controllers within one localized
store. A typical grocery store control system would contain
building management controllers and refrigeration
controllers.

Allows users to change the Language Setting.

Offers Global Search for your Site Homepage and global search for any Sites, Controllers, Devices, or

Unit

A unitis an individual controller at a site belonging to a
control system. There may be more than one unit in each
control system. One controller would be configured as
the gateway in the control system to communicate with
Connect+.

Application Type

An application type is the type of application that has been
set up inside a unit (controller). There are many types of
applications programmed into the controller. All application
types contain applications that belong to the same
application type.

Application types range from physical applications that
connect to a real device, such as air handlers, standard
circuits, sensor control, analog and digital combiners or
logical applications such as zones, power monitoring,
global data, time and dates, time schedules, user access and
more.

See below figure for REF Controller Application Types and
Building Controller Application Types examples:

Typical REF Controller Typical Building Controller
5 i 154 Atlanea = A E2
I HE = B 8x-400 1: HVAC/LTS

@ FBx-400 1: HVACATS
23 B re-400 2: RAK LT/TC

@ [3 Alarm/advisory Setup

# [3 arti-sweats

@ [3 Circuits (Standard)

4[4 Condensers

3 [A Digital Combinars

& [ Enhanced Suction

B [3 Flexible Combiner

& [3 General Serwp

& [3 Glebal Dtz

@ [ Legging Groups

@ [3 perf Alert

& [ physical a1

& [ physical D1

3 [{ Physical DO

i [ Physieal Pulse Ourot

# [ Rack Simulator

& [ Remots Dislout Setup

& [3 sensor Control AV

@ [3 Sensor Control DV

% [3 Time and Date

& [H User Access Levels
@ [ RX-400 3: PROTO A8
@ BR300 4: 2 Uning4

4 [3 Air Handlers (8HUs)
# [3 Alarm/Advisory Setup
# [3 Anzlog Cembiners
# [4 Digital Cembiners
) [3 Flexible Combiner
# [4 General Setup

# [3 Global Dats

# [3 Heat/Cool Control
# [3 HVAC Zones

@ [3 Lighting Control

# [§ Lecging Greups

@ [ Physical A1

# [4 Prysical 40

@ [ Physical D1

# [4 Physical DO

# [3 Power Monitoring

@ [3 Remote Dialout Setup
# [3 Sensor Cantrol AV
@ [ Sensor Control DV
# [3 Time and Date

4 [ Time Schedules

# [3 User Access Levsls




Application Instance

An application instance shows the application (if available)
that has been programmed inside a controller to access a
physical device or define the controller setting. Through
the application instance, users can either access a physical
device’s data points, such as an ice cream case controller, or
access applications that are programmed to configure the
controller, such as user access or alarm settings.

Point

Application points are attributes that have been
programmed inside a controller application. Access to
application points allows the user to view details about
the points, graph points, retrieve logs, and make changes.
In Connect+, there are three categories of points: Input,
Output, and Parameters.

Aninput point can be associated with an output point of the
same data type, and vice versa (for example, digital outputs
to digital inputs, analog inputs to analog outputs). An input
point cannot be associated to another input point, likewise,
an output point cannot be hooked to another output point.

e Active Points is the default each time the user
opens the browser and will show all configured
points in the controller.

e Active with Logs shows active points that have a
controller log available.

¢ Points with Logs shows points that have a
controller log available.

e All Points shows all possible points for an
application instance, whether a point is configured
or not. An icon appears next to the point if the
pointhas alog.

-
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2.3 Complete My Profile and Set
Preferences

2.3.1 Profile & Preference

To check your User Info to complete and set preferences,
click the icon next to your name and click User Info:

>x =coich [ . © Hello Fan

Set As Home Page
User Info

My Home Page

Logout

Complete Email

If you currently do not have an email, you need to enter a
valid email address. Without email information:

* You cannot receive emails from Connect+ when you
go through the Forget Password or Forget Login
ID process.

* You cannot receive the verification code during
login if your organization decides to activate
Multifactor Authentication.

Updated Password

If your organization has activated the Reset Password Every 90
Days option, you will be reminded to update your password
when your current password is expiring within 14 days.

Setting Preferences

In my User Information Preferences and Units section,
you can set your Connect+ Navigation Preferences and
Engineering Units.

» Show GS Screen Edit Tool: This allows the GS
Screen menu visible on the right-click tree menu.
Default is not enabled.

* Enable Home Page: This allows you to set your
Connect+ Homepage. Default is not enabled.



¢ Hide Nav Frame: This allows you to hide the
navigation tree. Default is not hiding.

e Enable GS Screen Auto Logout: This allows you
to be automatically logged off when the GS Screen
page is inactive for 30 minutes.

¢ Engineering Units: English/Metric/Global units.
Default is English units.

You can set your language preference directory from the
Enterprise Toolbar. Currently, you can only choose from
English or Spanish.

Hello Fan

>x ==t [ . ©

2.3.2 Set Connect+ Homepage

When you enable the Homepage Setting, you will see the
Set as Homepage menu option when you click the User
Profile icon next to your name. Currently, Connect+ allows
you to set Graphical Screens as your Connect+ homepage.

Itis recommended to set the Enterprise Advisory Map as
your Connect+ Homepage for overall optimal Enterprise
performance.

If the Advisory Map has been enabled for your organization,
you can access Advisory Map at the Directory Level. Click
your organization’s parent directory, or access from the
right-click menu > Advisory Map.

Camoee 2
Map  Satelite 4

=
(]

When you are on the Advisory Map page, you will see all
Sites in different alarming states. The Advisory Map allows
you to have a quick glance on your Sites’ status in the past
24 hours. Click Set As Home Page from the user profile
icon next to your name.

Map  Satellite

You can also set other Graphical Screens as your Homepage.
As introduced in the What is Connect+ session, Graphical
Screens are Floor Plans or Summary Screens are for real-
time store monitoring. You can access these Graphical
Screens from the Navigation Tree, when you right-click

any level, you will see a list of System Summary Screens
indicated with a blue icon, and customized graphical screens
indicated with an orange icon.

= @ Demo
+ iy 00211
+ ik 0215 Xian

154 Atlanta

[ Refrigeration Summary

[ Building Summary

s ] Other Summary

P Demo Refrigeration Summary

L]

FY E2 Store Summary
@ Summary

Open any Graphical Screen at any Tree Level, click User
Profile > Set As Homepage, and the Graphical Screen will
be set as your Connect+ Homepage.

Note: You can also set the Homepage for each Site. This will be
covered in more detail in the Graphical Screen session.




2.4 Manage Your Own List

A list contains points that you are interested in. You have
flexibilities to choose your preferred points from different
stores and controllers for the same Application Type to
compare store performance. Or you can also select a
number of points for a single store or controller to monitor.

You can also create your own list using the List Power
Builder. Access List Power Builder from the Header Menu >
List Power Builder > Add New.

Criteria
‘Watch Points Lists Use * (asterisk) for wildcard at the start or end of a match string.
Select 2 list to load or type in 2 new List Name to create a new List. | Separate multiple matches in a single field with commas. addivonal
Help
B Direcory ]
& site é
FiControl System
Lead List sakect st v g
Uniz
e S — ) I—
Beomen [ ]
Instance
Bl e e 2
| point
Add To List
List Size: 0
[TMe.]Dir Site [e= TUnic [App Type App Inst [Category Point
C T T I ) [ 2] N

You can create a new list by entering your criteria under

the Criteria section on the right as shown in the figure
below. For example, if you want to get all the case controller
temperature points, you can leave the Directory/Site/
Control System/ Unit blank and enter the case controller
Application Type name. If there are multiple names,
separate them by commas. Then enter the Point Name as
the same name from your tree. Click Add To List and the list
of points are retrieved as shown below.

You can also filter points and remove filtered items to
further refine your list.

Watch Points Lists
elect 3 list to load or type in 3 new List Name to create a new List. 2 match string. Separate multiple

Load Lisc e 5

Lsstme
e .
Er—
List Size: 10000
To o e

=z
2B

oy
lowa--Display Message
rdlarm

[ Fressestat imput = too lowa--Repest Rate

Page Sizes Next

‘Showing 1 - 10 of 10000

Enter a unique name for your list. Save As A New List button will display when you have a valid list name. Click Save, and you

can use this point list later to watch your store.

Watch Or Graph Points

I« 1. HVAC/LTS"/Air Handlers (AHUs)/1-MAIN AHU/OQutputs/SPACE TEMP OUT

|« 2. HVAC/LTS"/8ir Handlers (AHUs)/SALES AREA/Outputs/SPACE TEMP OUT

|#| 3. HVAC/LTS"/&ir Handlers (AHUs)/RTU-1 BAKERY/Outputs/SPACE TEMP QUT
|| 4, HVAC/LTS"/Air Handlers (AHUs)/RTU-2A PRODUCE/Qutputs/SPACE TEMP OUT
I#| 5, HWAC/LTS"/Air Handlers (AHUs)/RTU-2B PRODUCE/Outputs/SPACE TEMP OUT
|#] &, HWAC/LTS"/Air Handlers (AHUs)/RTU-3 KITCHEN,Outputs/SPACE TEMP OUT
I#f| 7. HVAC/LTS"/ Air Handlers (AHUs)/RTU-4 CONF RM/Outputs/SPACE TEMP OUT
I 8. HVAC/ Air Handlers (AHUs)/TT STORAGE/Outputs/SPACE TEMP OUT

I#| 9. HVAC/ Air Handlers (AHUs)/RECEPTION AREA/Outputs/SPACE TEMP OUT

[« 10. HVAC/ Air Handlers (AHUs)/REFG LAB/Outputs/SPACE TEMP OUT

I#| 11, HVAC/Air Handlers (AHUs)/SIDNEY CONF RM/Outputs/SPACE TEMP OUT

Display Log Graph Retrieve Logs + Graph Retrieve Logs Retrieve Logs + Export “

NOTE: Only the first 15 points will be us=d on the graph.




3 Advisory Map, Advisory View, and Live Advisories

Advisory is defined as the notifications or alarms generated
from Controllers to report store crisis. Currently Connect+
supports receiving Advisories directly from Emerson
Controllers E2, Site Supervisor, and Dixell. Connect+ can
also receive Advisories from Danfoss if a Danfoss Site is
sending alarms to the ProAct Alarm Service.

Advisory Type by Controller:

e E2: Alarm, Device Failure, Notice
« Site Supervisor: Critical, Non-Critical, Notice
¢ Dixell: NA

¢ Danfoss: Severe, Critical, Normal, Log Only

Advisory State:

Each advisory in Connect+ have two states: Active or
Return to Normal.

An advisory remains active until the condition to generate
the advisory returns to normal.

Active

An Advisory occurs when a controller generates the
alarm based on the alarm parameter configured. Alarm
parameters involved in advisory occurrence are High/Low
limit and Alarm Delay.

For example, technicians can configure Case Controller
Temperature Alarm Hi/Low limits for the normal
temperature range. And a 10-minute Alarm Delay. Once

the temperature is outside of the setpoint, either above Hi
Limit or under the Low Limit, the controller will wait until the
Alarm Delay passes and then generate an alarm.

The alarm will remain Active from the Advisory Occurrence
Time until the point value returns to normal.

Return to Normal

An Advisory will Return to Normal once the point value

is back inside the normal range. There is another Alarm
Configuration that will affect the Advisory Return to
Normal time: Alarm Hysteresis. When the Alarm hysteresis
is configured, an Advisory will change to the Return to
Normal state only when the current point value is in range
of (Hi Limit — Alarm Hysteresis) and (Low Limit + Alarm
Hysteresis).

Advisory Priority:

Advisory Priority is a concept with Emerson Controllers E2
and Dixell. Connect+ provides the same concept for these
two controllers.

e E21-99
e Site Supervisor NA
* Dixell 1-99

Urgency Level

Urgency Level is a Connect+ defined Advisory Property.

When you have multiple controllers across organization,
it is difficult to tell which Advisory need your immediate
attention with different Advisory definition for different

controllers.

In order to solve this problem, Connect+ defined Urgency
Levels as shown below. This allows users to have a consistent
view of Advisories Severity. Currently the definition is
defaultin Connect+:

Advisory Priority for E2 and Dixell

. Example

Room Temp

Urgency

Alarm
1to 20 pe— d
ase Temp an
Food Safety e
Active  Heat Pump
21to50 Status Block
Alarm
Low 511099 HRC Alarm from
Heat Pump
Low 1to99 RTN

Advisory Priority for Site Supervisor

o Example

Room Temp

Urgency

Alarm
Critical E— d
Food Safety dse ‘empan
. Prod Temp
Active
Heat Pump
Non-Critical Status Block
Alarm
Low Notice
Low Any RTN

~N



3 1 AdViSO Fy Ma p Map  Satellite 2 MICHIGAN o = sewraos L
° w)

NEw
HAMPSHIRE

'YOMING 4 NEW YORK
Chitess Dot MAS SACHUSETTS!
1owa s Ea
NEBRASKA CT el
3.1.1 Access problematic . Conal it
ce oy United States o 2 Ny,

Kansas Cit Indienapolis " NARVLRND
UTAH 25 City ianapolis

stores via Advisory Map .-
Las Yegas 'm Na .'-

L T Tenesste oY= +
If your organization has enabled = > o
. H oy o (gl MISSISSIPPI
Advisory Maps, when you click the peve e i
parent directory in the Navigation 2

Houston

Tree, you will see an Advisory Map A s

- ° Bermuda
Tugson TEXAS

BAIA <
CALIFORNIA N Austin
SoNORA 3

or
. . % conmuA, SR
as shown below with the Advisory % =
Urgency legends. You can set this ot e s, ety s R
Mexico favana
page as your Connect+ Homepage for y - e

Map data ©2020 Google, INEGI Terms of Use |

14

Enterprise View. ) - .

Sites in the Advisory Map are indicated with an Alarm Urgency Level in the past 24
hours. You can click on any problematic Sites to further investigate based on the
below legends:

Site Severity Level

* Red indicates Sites with Food Safety Alarms/High Alarms.
e Orange indicates Sites with Medium Urgency Alarms.
* Yellow Indicates Sites with Low Urgency Alarms.

¢ Green indicates Sites that does not have active Alarms.

Mo Alarm Connection

* Grey and Flashing indicates Sites without Alarm Connection.
Past 24 hours

If you know your Site Name, you can also enter the site name in the search box.
The search result will flash for 5 seconds on the Advisory Map for you to check
further details.

When you click the Site, you will see a snapshot of the Site, which includes Site
Name, Site Address, and several quick links:
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7 * When clicking Controller
g ; View, you will be log into
\ J N\ - Controller Terminal Mode.
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The Advisory Map View allows you to review your stores and locate problem sites as quickly as possible. The quick links for each
site provide access to locate advisory information and take further actions. From Advisory View, you can review Alarm Details
with Log Graphs. From Controller View, you can access Terminal Mode if you need to change settings to clear the alarm.

3.2.1 Your Advisory Map Setting

Map  Satellite \ gt ot B > Semhat= ‘Q’
% - e Iceland i e
Norway Fieland Site. Er Level
Canada Hislnex Hay Advisory Map View Setting
Ber g a T @ Show Legend | 3 )
= ® All Sites e T v polong oS A
Only Sices With Adviseries A J itk Past 24 hours
£ = - P T, B N : Kazakhstan
J el ; Sites with Food Safety Advisories Crbe !
o " 7 @ Sites with High Severity Advisorizs % ! . +
- W it Uzbekistan .| J
‘ nited s‘“.'_E @ @ Sites With Medium Severity Advisories o el Greece Turkey B Turkmenisian. —
=) oK = ¢ % Sites With Low Severity Advisories Tuniel ! Afghanistan
North . 4 oo raq Iran
5 J.C fic ° Sites With No Alarm Connection % Pakist .Q
Ocean Algeria (]
v Libys Egypt )
Mexico Sehaa Saudi Arabia nd
[ concet | x| b :
Mauritania| i
/ ched Sudan Yemen
i pirtna., Guf of Ades rabian Sea
- Venezusla Lo G“‘_’f' y ) N'q'f'“ \ il ‘South Sudan EMMioRia A
: Colombia | " surmma: ' eutorGunes Somalia
e i A ek i 5 ~_/Kenya
_______________ \ E:ul-dur ) - DRC
Y, ¥ / o 0, Pl "‘"‘m — Tanzania
B | g’ 5 B'a_l” e L Angola {
Google .~ ! H 4 % Z8mbia . M Maptiata-©2020 Google, INEGI | Terms of Use
1. Map or Satellite View: Allows Map  Satelite
toggling between Google Maps
view or Satellite view. With the
satellite view, you can view
a real image of your stores, s
ometimes including roof top
unit views.
2. Setting: If you have many
stores, your Advisory Map
might appear crowded. You can
filter your stores in the Advisory
Map to have focused views:
Once you Click OK, your Advisory Map View Setting
Advisory Map Prefe:rence is 2 Show Legend
saved. When you view the
. . . = Al Sites
Directory Advisory Map again,
it will only show the sites with Only Sites With Advisories
yOUF Set preferences. o o Sites with Food Safety Adwvisories

i 9 Sites With High Severity Advisories
s Sites With Madium Severity Advizeries
7

Sites With Low Severity Advisories

o Sites With Mo Alarm Connecticn




3.2 Advisory View

The Enterprise toolbar alarm icon provides a quick overview of how many total active alarms you have across your stores in
the past 24 hours. Whenever there is new alarm received by Connect+, the number will increase and flash for several seconds.

A

3 i
%
EMERSON A

3.2.1 Advisory List View

You can access the Advisory List View when you click this toolbar. As in the Advisory Map View, the Advisory List View is
organized by Advisory Urgency Level:

Advisories View
Occurrence Date | Past 24 Hours ¥ |  Time Perspective: | Site Time v Show
(O ResetFilters {3 Refresh Advisories ¥ Restore Default Format
A State Occurrence Date Age Site. Type Advisory Message Source Prio.. Application Insta.. Source Type Status Point Limit
Active ~ Al Al e Al |
E aeve 4/25/20208:29 A1 10.5h Alarm  Case Temp Hi Limit Exceeded 20  Al2 SDKBEER  Devicz Accepred  CASETEMP 2 48.0
EREEE 4/25/20209:45 AM  16.2h Fail Controller Not Sending Alarms sinc.. 10 System Accepted
B actve 4/25/202012:03 AM  19.5h Notice  Compressor Cycle Rate Exceeded 60  RackCSuction  CBMainte.. Accepted  CYCLE RATE STA.. 240.0
B actve 4/24/2020 10:46 PM 21.2h Fail Controller Not Sending Alarms sinc.. 10 System Accepted
E e 4/24/2020 10:46 PM 21.2h Fail Controller Not Sending Alzrms sinc.. 10 System Accepred
ERGET 4/24/2020 10:46 PM 21.2h Fail Controller Not Sending Alams sinc.. 10 System Accepred
ERGEE 4/24/2020 10:46 PM 21.2h Fail Unknown Cade: 20,001 (Controller.. 10 System Accepred
B actve 4/25/2020 4:46 AM  21.2h Fail Controller Not Sending Alarms sinc.. 10 System Accepted
B actve 4/25/2020 4:45 AM  21.2h Fail Controller Not Sending Alarms sinc.. 10 System Accepted
ERGEE 4/25/2020 8:16 AM  21.2h Fail Controller Not Sending Alzrms sinc.. 10 System Acceptad
ERGEE 4/24/2020 10:46 PM 21.2h Fail Controller Not Sending Alamms sinc.. 10 System Accepred
ERE 4/25/20204:46 AM  21.2h Fail Controller Not Sending Alamms sinc.. 10 System Accepred
EREE 4/24/20209:45 M 22.2h Fail Unknown Code: 20,001 (Controller.. 10 System Accepted

Occurrence Date

Received Date

Displays the date time when the advisory was generated on the controller.
Displays the date time when the advisory received in Connect+.

Displays advisory duration:

Alarm Age e If the advisory is still active, Alarm Age = Current Date time — Occurrence Date.
* If the advisory is return to normal, Alarm Age = Return to Normal Date - Occurrence Date.
RTN Date Displays the date time when advisory is back to normal.
Source Displays controller, application, and property information from which the advisory was generated.
Source Type Besides controller, Connect+ will a.Iso gepgrqte Advisories. Such as Fontroller Offline Alar.m, !Dredictive Maintenance
Alarm, and more. Source Type indicates if it is from Controller, Device, or Connect+ Applications.
Point Displays point from which the advisory was generated.
Limit Displa.y§ the high or low I.im.it the advisory will exceeded to generate the advisory. This is usually configured by your
technician during commissioning phase on the controller.
Trip Value Displays the point value when advisory is generated.
e (I?ri]sErl]aeycsoar?tre(;[laelination of the advisory. This is usually configured by your technician during commissioning phase
Add Comment Users can add comment of the selected advisory.
Comment Displays the latest comment user added.
Different Controllers using different Type to categorize Alarm Severity.
Type e E2: Alarm, Fail & Notice for E2
* Site Supervisor: Critical, Non-critical & Notice
Priorities Displays urgency level of advisories as numerical (1-99). It is configurable in Controller
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3.2.2 Read Alarm Related Log Graph

From the Advisory List View, you can access Advisory Detail Information and log into the controller (if needed):

* Access Point Log Graph from Advisory Message Link

From Advisory View, you can only see the alarm-related points Log Graph. The same applies to the Log Graph in Advisory Email.
You can read the multiple points Log Graph from Watch Points & Graphical Screens.

I (A 14 4H 12H 1D 2D 4D W AW -
3¢ = e belo Fam Ding
From |2um-m—m 14:45:00 |E T |2mn-na—2ms-45-nu|m B a0 =
Ala Propert) Propel -
CASE TEMP 1 F CASE TEMP 1 F
DEFROST on Case Alarm Hi 15.0°F
4 »
75
L]
50 Shaw [25
w25
case temp
o Case Temp Hi Limit Exceeded CASETEMP 1 16 A12 RIBEER Device
Case Temp Hi Limit Exceeded CASE TEMP 1 20 A9 SALADBAR  Device
Case Temp Low Limit Exceeded CASETEMP L 16 LTiGROC Device
-25
Case Temp Hi Limit Exceeded CASE TEMP 1 16  LTiGROC Device
15:00 15:30 16:00 16:30 17:00 17:30 18:00 18:30
Case Temp Low Limit Exceeded CASETEMP 1 16 T2RIFROZ D Device
-=- @ 154 Atlanta/LT3 RI FROZ FD/CASE TEMP 1 w—p= {fj 154 Atlanta/LT3 RI FROZ FD/Case Alarm Hi (no log in controller) Caze Temp Low Limit Excasded CASE TEMP 1 15 \T4 RIFROZ FD  Device
Highcharts.col
on e Case Temp Low Limit Exceeded CASETEMP1 16  [T3RIFROZFD  Device
S
o Off
=
S na
15:00 15:30 16:00 16:30 17:00 17:30 18:00 18:30
1§ 154 Atlanta/LT3 RI FROZ FO/DEFROST -
S5 Dev ‘

m From the Advisory List View, there are other quick links to:
escription

Set the time range of the data to show

Log Graph Range point log in the graph. * Access Site Home Screen from Site Link

Displays advisory point and its related * Access Controller Summary Screen from Unit Link

AETSEITE points value and alarm status.

» Access Application Summary Screen from

Point Lo Displays advisory point and its related Application Type Link
9 points log in graph.

Defrost Cycle Displays defrost status in graph.
You can choose time perspective, down-
Setting load, print, save log graph date range as
default.
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3.2.4 Filter Advisory List View

Filter Advisory List by Urgency Level or Occurrence Time

Advisories View

becurrence Date [Past 24 Hours v ] | TimeBe : [Sits Time hd Shew [25 ¥

Past Month

it Custom Rangs

| 4[25/2020 8:29 AM . LCase Temp Hi Limit Exceeded A12 SDK BEER CASE TEMP 2 28.0
® E Active 4/25/2020 9:46 AM 163h Fail Controller Not Sending Alarms sinc_ 10 Systam Accepted
® E ave 4/24/2020 10:46 PM 21.3h Fail Contraller Not Sending Alarms sinc... 10 System Accepred
® E aive 4/24/2020 10:46 PM 21.3h Fail Contraller Not Sending Alarms sinc... 10 System Accepred
O F e 4/24/2020 10:46 PM 21.3h Fail Contraller Not Sending Alarms sinc... 10 System Accepted
@ F i 4/24/2020 10:46 PM 21.3h Fail Unknown Code: 20,001 {Controller... 10 System Accepted
® F e 4/25/2020 4:45 AM 213 h Fail Contraller Not Sending Alarms sinc... 10 System Accepted
O E e 4/25/2020 4:46 AM 213 h Fail Controller Not Sending Alarms sinc_ 10 Systam Accepted
O E e 4/25/2020 8:16 AM 213 h Fail Controller Not Sending Alarms sinc__. 10 Systam Accepted
@ [F Aave 4/24/2020 10:46 PM 21.3h Fail Contraller Not Sending Alarms sinc... 10 System Accepred
@ [F Aae 4/25/2020 4:46 AM 213k Fail Contraller Not Sending Alarms sinc... 10 System Accepred
® B awe 4[24/20209:46PM  22.3h Fail Unknown Coda: 20,001 (Controller... 10 System Accepred

Filter Advisories by Filed Filter: For example, if you enter Case Temp in the Advisory Message field, all the alarms will be
filtered with Advisory Message that contains Case Temp.

Advisories View

Occurrence Date [Past 24 Hours Time Pe: ive: [GteTime V] Show (25 ¥

4/25/2020 8:29 AM 107 h i 3 20 A12 SDK BEER Acceptad CASE TEMP 2

3.2.5 Customized Advisory List View

You can customize your Advisory List View by:

e Adding or removing more columns as indicated below.
e Dragging the column header to reorganize your field sequence.

¢ (Clicking on each column header to sort the list.

Your preferences will be saved for future viewing:

Occurrence Date Time Parspective: Show (25 ¥
[¥] Add Comments
Unit ID
[¥] State
2} Sort Ascending (4] Oczurrence Datz A Y e
@ [ saive 4/25/2020 8:29 AM 10.6h 2] SertDescending 20 A12 SDK BEER Device Accepted CASE TEMP 2 48.0
A
A
® |i| Active 4/25/2020 9:46 AM 16.3h Iﬁ @ o= = 10 Systam Accepted
umns Site
® B 2 4/24/2020 10:46 PM  21.3h R 10 System Accepted
Type
ive : L i ontroller Not Sending System
Acti 4/24/2020 10:46 PM  21.3h Fail Controller Not Sending 2 10 s d
Advisory Message
® [F ave 4/24/2020 10:46 PM  21.3h Fail Controller Not Sendind o 10 System Accepted
Source
® [F ave 4/24/2020 10:46 PM  21.3h Fail Unknovn Cads: 20,00| & 10 System Accepted
Sriort
® [F sawe 4/25/2020 4:46 AM 213 h Fail Controller Not Sending &1 PrieitY 10 System Acceptad
Active 25/2020 4:46 AM 213 Fi Controller Mot Sendin 10 System Accepte
225/ h i m ding [¥] Application Instance ¥ 4
Active 25/2020 8:16 AM 213 Fai Controller Not Sendin 10 System
4/25/ h I i ding | [ESUE= e » Accepted
® [ o 4/24/2020 10:46 PM 213k Fail Controller Not Sendind (2] St3tUS 10 Sysrem accepred
® [ s 4/25/2020 4:46 AM 213k Fail Controller Not Sending Directory 10 Systam accepted
® E acie 4/24/20209:46 M 22.3h Fail Unknown Code: 20,00 Emird Em 10 System Accepted
Application Type
[¥] Point
“« »
o
[¥] Trip Valee
b
B e
Par
. ) ) [¥] Urgency
: low n) indicates an advisory has returned to normal. The resul our search may contain ata cor hdin s earier than nge.
Notes: A type followed by (rtn) indicate advisory has returned to | Th lts of yt rch may contain extra data correspdhding to dates earlier th: 9
[¥] Cemments
[#] Received Date
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3.2.6 Access Advisory List View from Navigation Tree

You can also access the Advisory View from all levels in Navigation Tree by clicking
Right Click Menu > Advisories > View Advisories.

This allows additional flexibility to access Advisories at a certain Site, Controller,
Device, or a known Point.

3.3 Live Advisories

If your organization will not enable Advisory Receiving in Connect+, your
advisories can be viewed in Live Advisories. Connect+ will access the Control
System or Controller to get Live Advisories on the Controller when you click Right
Click Menu > Advisories > View Live Advisories from the Navigation Tree at the
Control System or controller level.

|= W Demo
+ iy 00211
+ iy 0219 Xizn
£l
+ i 100 Kennesaw
+ iy 152 Lab

154 Atlanta

2. ] Refrigeration Summary

] Building Summary

2.} Other Summary

7y Demo Refrigeration Summary

F8 Summary
Configure
File

Activities

| E2 Store Summary

Advisori

Setpoint]

Food Qu

View Advisories

] ﬁ Forward Advisories

Connection Verification Report

Configure Advisory Purge

& Configure Advisory Snooze
A Configure TAC Advisory

Energy
CB Maintenance 3
Refrigerant I -
Live Advisories View
Qezurrence Date Shaw
(ResetFilters 3 Refresh Advisories ) Restore Default Format
| | Occurrence Date v Type Unit Source Prio... Status Advisory Message Advisory Limit Property Value
Al v Al v
04/25/2020 16:06:02 Alarm (rtn) RX-400 3: PROTO A/B  PROTO A/B:B23B FISH CLR :PRODUCT TEMP 1 20 Unacknowledged Product Temp Hi Limit Exceeded 41.0 66.2 -
04/25/2020 10:06:12 Alarm (rtn) RX-400 3: PROTO A/B  PROTO A/B:B23B FISH CLR :PRODUCT TEMP 1 20 Unacknowledged Product Temp Hi Limit Exceeded 41.0 66.2
04/25/2020 04:06:03 Alarm (rtn) RX-400 3: PROTO A/B  PROTO A/B:B23B FISH CLR :PRODUCT TEMP 1 20 Unacknowledged Product Temp Hi Limit Excesded 41.0 66.2
04/24/2020 22:06:12 Alarm (rtn)  RX-400 3: PROTO A/B  PROTO A/B:B23B FISH CLR :PRODUCT TEMP 1 20 Unacknowledged Product Temp Hi Limit Exceeded 41.0 66.2
04/24/2020 16:06:02 Alarm (rtn) RX-400 3: PROTO A/B  PROTO A/B:B23B FISH CLR :PRODUCT TEMP 1 20 Unacknowledged Product Temp Hi Limit Exceeded 41.0 66.2
04/24/2020 10:06:02 Alarm (rtn) RX-400 3: PROTO A/B  PROTO A/B:B23B FISH CLR :PRODUCT TEMP 1 20 Unacknowledged Product Temp Hi Limit Exceeded 41.0 66.2
04/24/2020 04:06:17 Alarm (rtn) RX-400 3: PROTO A/B  PROTO A/B:B23B FISH CLR :PRODUCT TEMP 1 20 Unacknowledged Product Temp Hi Limit Exceeded 41.0 66.2
04/23/2020 22:03:51 Alarm (rtn)  RX-400 3: PROTO A/B  PROTO A/B:B23B FISH CLR :PRODUCT TEMP 1 20 Unacknowledged Product Temp Hi Limit Exceeded 41.0 66.2
04/23/2020 16:06:01 Alarm (rtn)  RX-400 3: PROTO A/B  PROTO A/B:B23B FISH CLR :PRODUCT TEMP 1 20 Unacknowledged Product Temp Hi Limit Excesded 41.0 66.2
04/23/2020 10:06:18 Alarm (rtn) RX-400 3: PROTO A/B  PROTO A/B:B23B FISH CLR :PRODUCT TEMP 1 20 Unacknowledged Product Temp Hi Limit Exceeded 41.0 66.2
04/23/2020 04:06:02 Alarm (rtn) RX-400 3: PROTO A/B  PROTO A/B:B23B FISH CLR :PRODUCT TEMP 1 20 Unacknowledged Product Temp Hi Limit Exceeded 41.0 66.2
04/22/2020 22:06:18 Alarm (rtn)  RX-400 3: PROTO A/B  PROTO A/B:B23B FISH CLR :PRODUCT TEMP 1 20 Unacknowledged Product Temp Hi Limit Exceeded 41.0 66.2
04/22/2020 16:06:07 Alarm (rtn)  RX-400 3: PROTO A/B  PROTO A/B:B23B FISH CLR :PRODUCT TEMP 1 20 Unacknowledged Product Temp Hi Limit Excesded 41.0 66.2
04/22/2020 11:33:19 Alarm RX-400 3: PROTO ... PROTO A/B:ATC MONITOR A :COMMAND OUT 15 Unacknowledged Digital Sensor Alarm OFF OFF
04/22/2020 11:33:19 Alarm RX-400 3: PROTO ... PROTO A/B:ATC MONITOR B :COMMAND OUT 15 Unacknowledged Digital Sensor Alarm OFF OFF
04/22/2020 11:27:24 Alarm (rtn)  RX-400 2: RAK LT/TC RAK LT/TC:LT2 RI FROZ FD:CASE TEMP 1 16 Unacknowledged Case Temp Hi Limit Exceeded 10.0 13.2
04/22/2020 11:26:20 Alarm (rtn)  RX-400 3: PROTO A/B  PROTO A/B:B21A SVC PLTRY: CONTROL TEMP 16 Unacknowledged Comb Temp Hi Limit Exceeded 41.0 40.0
04/22/2020 11:75:18 Alarm (0] R¥-400 3. PROTO AR PROTO A/R:\walk-in Cooler:CASF TEMP 1 15 Unacknoswledoed Case Temo Hi Limit Fxcesdad 41 0 328 4 h
14 4 | gunas cE2c| b M| £ Disnlasinn arhisries 1. 25 of 12

Cleared Date
Status

Displays the date time when advisory is cleared on controller.

Displays whether the advisory has been Acknowledged, Unacknowledged, or Muted.

As with the Advisory View, you can sort, filter, and add more columns for your review. You can also export to Excel, PDF or

HTML files.
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4 View Sites Not Sending Alarms

Sites that are grayed out are sites not sending alarms from Advisory Map. To determine the number of sites not sending alarms
and more information, you can click the Sites not Sending Alarms icon on Enterprise toolbar.

EMERSOMN

Hello Fan

You will see a list of sites that are not sending alarms in the Connection Verification Report.

Connection Verification Report

Time Perspective: | Site Time ¥|  view|problem Sites v

Demo 152 Lab Site Supv 2 2
L 1003 Xweb EVO 1
L 1006 Xweb EVO 1
Asia Demo Demo Site Supervi..  Demo SS 1 1
Demo 249 NVC SsandE2 4 4
L 1001 Xweb EVO 1
Demo 250 Wske Forrast  SG Peer 1 1
D D D

Demo Chillventa XwebEVO 1
Demo EVO Dev Xweb EVO 1
Demo Chillventa XWES EVO Fizr 1
asia Demo Controls 2 Controls 2 il
B D o

Demo 54 Charlome Xweb300 1
Demo HwebEVO Xweb EVO 1

Sho

Last Received Time »

10/23/19 4:52 PM
4/9/19 6:12 PM
5/17/18 1:14 BM
4/8/19 10:55 AM
11/7/18 3:02 PM
5/2/18 4:35 PM
6/15/18 9:40 AM
9/18/19 9:49 AM
11/29/18 3:46 AM
9/4/19 5:01 PM
3/3/20 7:03 AM
4/2/19 1:24 PM
1/29/20 10:53 AM
10/18/19 2:20 AM
10/4/19 4:56 PM

2/18/20 1:57 PM
6/12/19 2:52 PM
6/12/19 2:52 PM
5/8/19 3:29 PM
1/21/19 10:11 PM
12/6/18 B:51 AM
7/2/18 7:37 AM

4/25/20 5:12 AM

4(25/20 11:02 AM
4/24/20 8:07 PM

4/24/20 5:07 PM

Test Connections
per Day

Number of Missed
Connections

Last Received Time

Next Received Time

Commissioned Date

14

Displays the number of connection tests
that occurred for the controllerin 24
hours.

Displays the number of connection tests
missed for the controllerin 24 hours.

Displays the date and time when the
latest connection test or alarm was
received.

Displays the date and time when the next
test connection will occur.

Displays the date and time when you
configured to send an advisory config-
uration such as connection test time
and advisory filter priorities for alarms,
failures, and notices for E2 and Site
Supervisor. And displays the first refresh
unit date time as commissioned Date for
XWEB and Danfoss.

Repg Conmection erficationHitory
| [Demo / 152 Lab / site supy
Fime Perspactve: [Sea Trme Host recent 30 connections will be shown.
(CResetFiters G Refresh Connections. —
Dremey s ol 51
| 21820 10158 4
| oems ey Seesun |
s 1003
L 1006 x
oems 2sm0C ssanie2
N . 2717720 514 A
oems 250 wakaForr. S5 eer
° ° °
oem: Chivers xwssevo
oems £v00er xoE| |
oem Chiera  xwEBEVO,
Asadamo  Coneel
s ° °
oems SiCharome XuebS00 T 10/18/19 2:20 8
oem XSO Xueh VO 1 10419 4136 U

As with Advisory View, you can sort, filter, and add more
columns for your review. You can also export to Excel, PDF
or HTML files.



5 Monitor Site from Graphical Screens

5.1 Graphical Screen

Graphical Screens are floor plans or summary screens for
real-time store monitoring. You can access these Graphical
Screens from the Navigation Tree, when you right-click on
any level, you will see a list of System Screens indicated
with a blue icon, and Customized Screens indicated with an
orangeicon.

¢ System Screens are provided by Connect+
with predefined summaries at Site, Controller,
Application Type, and Application level.

e Customized Screens can be developed by your
Admin or Emerson to facilitate your customized
needs to monitor or compare store performance.

5.2 What You Can Do with Graphical Screens

= @ Demo
+ iy 00211
+ ik 0215 Xian

154 Atlanta

Ea Building Summary
[ Other Summary

Eﬂ E2 Store Summary
Ei! Summary

Ea Refrigeration Summary

E;! Demo Refrigeration Summary

You can right click on Point Value and Override a Point, you can also Display Log Graph, Real Time Graph, and View
Advisories for the Point. Note you can only use the right-click menu in a Point value field.

Mo application instances of this bype

Refrigeration Summary

Mo application instances of this type

Configure Advisory Snoozs

RX¥-400 2: RAK LTYTC RACK LT L 15.0 PSI NONE = - - 4
RM-400 2: RAK LTyTC RACH TC 20.0 PEI 15.0 P51 NOMERSE SUCT MON TEMP ry 100.0 %% 0K
R¥-400 3: PROTO A/B FROTOCOL A 54.0 PRI 50.0 PSI L 5 & 100.0 %% Ok
RX-400 3: PROTO A/B PROTOCOL B £3.0 PSI 54.0 PSI L = Qwerride & 50.0 % OK
Display Log Graph
Graph Collaction 3
Unit Condenser P Cirl 2= Show on Real-time Graph VS O State
RX-300 4: EZ Unitd4 COMNDENSER MNONE FSI 20000 FS] P Fanis} On
RM-400 Z: RAK LT/TC COMDENSER LT 2162751 210.07S]  Doint Broperties r? Fan{s) On
RM-A00 2: RAK LT/TC COMDENSER TC 172.4 P51 180.0 #s] ? Fan(s} On
RX-400 3: PROTO AJE COMNDENSER A r? ?? Connaction Verificztion Repert r? Fan{s) Of
RX-400 3: PROTO AJE COMNDENSER B 15000 P51 222.0 F5] ? Fanis} OIT
Forward Advisories
View Adviseries
Create Setpoint Broadcoast
Unit Circuit {CC] Alarm State Te ek

REFRIGERATION -9.3 9F -12.0 °F

andard) Alarm___State _ Temp Setpt IR

) D REFRIGERATION -1.4 9F 0.0 9F
Configurs C& Maintznance o REFRIGERATION 0.0 °F 0.0 °F
Configure Log Purge D REFRIGERATION -2.2 9F 0.0 OF
D REFRIGERATION -1.7 9F 0.0 °F
Edit Application Instance MT REFRIGERATION 1.0 OF 0.0 OF
D REFRIGERATION -0.5 9F 0.0 oF

R¥-40D 2: RAK LT/TC LTEBA DT MEAT REFRIGERATION -1.6 9F -1.0 9F
RX-ADD I: RAK LT/TC LTEB DT MEAT REFRIGERATIOM 0.1 BF 0.0 oF
R¥-40D 2: RAK LT/TC LTEC DT MEAT REFRIGERATION 25.0 °F 28.0 °F
RX-AD0 I: RAK LT/TC LTS SEAFD FRZR REFRIGERATIOM -7.5 9F 0.0 oF

R¥-40D 2:

Y [ e

RAK LT/TC MEAT PREP 30

REFRIGERATION 42.7 °F 50.0 °F

-
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"
E L. —
i =R

o= [220 0225 21:50.35] Show Evpanded Legend
30 minutes
. . . . . 1.00 || 45 minutes
While you can View Point Log Graph from Advisory View, Lo
Advisory Email, Watch Point and Graphical Screens, you can
only View Point Real Time Graph from Graphical Screens.
Real Time Graph allows you to watch the Point value change LLU N
. . . . . A . i M 154 Atlancz/LT1 GROC/CONTROL TEMP
in real time for different time intervals from 5 minutes up to . JR S S
1 hour. You can also add more points from the Graphical v =

- 154 Atlanta/LT4 RI FROZ FD/CONTROL
© My

Screen to Real Time Graph by right-clicking on the point
value. The point path will be shown on the real time graph.

Shaw full path point lise

5.3 System Summary Screen

Tree Level Name Description
Refrigeration Summary Includes critical points from Suction Group, Condenser, and Case Controllers.
Building Summary Includes critical points from Outside/Inside Temp and Humidity, AHU Temp &
Status, Lighting Status, and Schedules.
Other Summary Includes critical points from Anti-Sweat, Demand Control, Power Channel, Analog

Sensor, and Digital Sensor.

Controller Summary Sites usually has multiple controllers:

« Building Controller Summary is a subset of Site Building Summary for that
specific controller.

 Ref Controller Summary is a subset of Site REF Summary for that specific
controller.

Summary Includes critical points for below Application Types:

Circuits and other Case Controllers, Condenser, Suction Group, Physical Al/DI/
App Type DO, Sensor Control AV/DV, HVAC Zone, Lighting Control, Power Monitoring, An-
ti-Sweat, Analog Combiner, Digital Combiner, Flexible Combiner, and more.

Defrost Summary Only applies to Case Controller Application Types

Status Includes critical input, setpoint and output points properties for Application
Instance. Only an App Instance from an Application Type that has Summary Screen
will have a Status Screen. (See App Type > Summary)

Graphical Summary Can be found in Application Instances from AHU, Condenser, Circuits, Suction
Group, Sensor AV/DV for graphical presentation of the physical device.

How to Read Summary Screens

Summaries comprise several tables. The table header is defined as:

“Controller Name” “App. Instance Name” Point Value Point Value Point Value




In the below example, each table header has Unit as fixed header, with different Application Type such as Enhanced Suct Grp,
Condenser, Circuit (CC) and Circuit (Standard). For each Application Type, point is also different.

ALARMING!
Fnhanced Suct Gro Such Suct S| — - — tive Stages tal Stages 0o C; S e
RX-400 2: RAK LT/TC RACK LT 17.0 PSI 15.0 PSI oF 'S1 [] ] 100.0 % []3
RX-400 2: RAK LT/TC RACK TC 20.0 PSI 15.0 PSI of S| 2 2 100.0 % oK
RX-400 3: PROTO A/B PROTOCOL A 54.0 PSI 50.0 PSI °F 1500 RSl 6 6 100.0 % oK
RX-400 3: PROTO A/B FROTOCOL B 52.3 P51 54.0 PSI oF S 5 & 83.3% oK
Controller Name/App. Ins. Name Point Value
R¥-300 4: EZ Unit04 CONDENSER MNOMNE PSI 200.0 PSI ?? ? ?? T? Fan(s) On
RX-400 2: RAK LT/TC COMNDENSER LT 213.1 P8I 210.0 PSI 2?2 ?? ?? ?? Fan{s) On
RX-400 2: RAK LT/TC CONDENSER TC 182.3 PSl 180.0 PSI ?? *? P ?? Fan{s) On
R¥-400 3: PROTO A/B CONDENSER A ?? ?? 87.0 °F 69.5 °F ?? ?? Fan(s) O
RX-400 3: PROTO /B CONDENSER B 150.0 PSI 2220 P51 2 *? ?? ?? Fan(s) O
Summary Table Header Unit/Application Type Name
3 CC 4 . P ; Emp el -
No application instances of this Lype . - REFRIGERATION -9.3 °F -12.0 °F
RX-400 2: RAK LT/TC LT2 RI FROZ FD o REFRIGERATION 0.7 ©F 0.0 °F
RX-400 2: RAK LT/TC LT3 RI FROZ FD - REFRIGERATION -0.4 °F 0.0 °F
RX-400 2: RAK LT/TC LT4 RI FROZ FD - REFRIGERATION 0.7 ©F 0.0 °F
RX-400 2: RAK LT/TC LTS RI FROZ FD . REFRIGERATION -2,0 °F 0.0 °F
R¥-400 2: RAK LT/TC LT6é MD FROZ MT = REFRIGERATION -1.6 ®F 0.0 °F
R¥-400 2: RAK LT/TC LT7 RI FROZ FD ss REFRIGERATION 1.7 ®F 0.0 °F
RX-400 2: RAK LT/TC LTEA DT MEAT = REFRIGERATION 0.4 ©F -1.0 °F
R¥-400 2: RAK LT/TC LTEB DT MEAT - REFRIGERATION -1.2 ©F 0.0 oF
R¥-400 2: RAK LT/TC LTBC DT MEAT - REFRIGERATION 28.6 ©F 28.0 *F
R¥-400 2: RAK LT/TC LTS SEAFD FRZR - REFRIGERATION -7.5 9F 0.0 oF =
RX-400 2: RAK LT/TC MEAT PREP 30 - REFRIGERATION 46.6 °F 50.0 =F

5.4 View Customized Screens

Your organization Administrator, Service Provider, or
Emerson Project Team might have developed Customized
Screens for you. Connect+ Graphical Screen Tools provides
different widget to allow library images and visual
presentations of your store to be created.

You can view store floor plans as shown below or pull data
from several stores to compare Food Safety Setpoints.
Consult your Administrator, Service Provider, or Emerson
Project Team about your needs. You can set a Customized
Screen as a Homepage or Site Homepage for quicker access.
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6 Watch and Graph Points

6.1 Watch Points

18

(%]

fresh | Active Points v ° 0

= @ Demo -
= i 00211
= i 0219 Xizn
ER
+ i 100 Kennesaw
+ 152 Lab
= i 154 Atlantz
FSLE2

# B BX-400 1: HVAC/LTS
= B Rx-400 2: RAK LT/TC
# [3 Alarm/Advisory Setup
4 [ Anti-zwvests
= [3 Circuits (Standard)
SRy
= &) Inputs
[]| - case TEMP 1
[/]| - case TEMP STPT
[ EMERGENCY OVR
[ LEAD CIRCUTT
[]  PRIDEMAND SHED
[]  SEC DEMAND SHEL
[ ST&RT DEFROST
# (@ Outputs
# B Params
H { Virtuzl

(%]

fresh | Active Points v ° 0

= @ Demo -
= i 00211
= i 0219 Xizn
ER
+ i 100 Kennesaw
+ 152 Lab
= i 154 Atlantz
FSLE2

# B BX-400 1: HVAC/LTS
= B Rx-400 2: RAK LT/TC
# [3 Alarm/Advisory Setup
4 [ Anti-zwvests
= [3 Circuits (Standard)
SRy
= &) Inputs
[]| - case TEMP 1
[/]| - case TEMP STPT
[ EMERGENCY OVR
[ LEAD CIRCUTT
[]  PRIDEMAND SHED
[]  SEC DEMAND SHEL
[ ST&RT DEFROST
# (@ Outputs
# B Params
H { Virtuzl

Watch Points: It allows the user to view the real time value of the points.

When you click on the Watch Point Icon, you will be directed to Watch or Graph
Points page.

Watch Or Graph Points

Select points to watch or graph by using the checkboxes in the tree.

Load Selection from list |...select list... v

Notes:
Disabled point names indicate points which only have logs and cannot retrisve real time values.

List Power Builder

You can select Points to watch or Graphs using the checkboxes in the tree or load
Points from a list.

Select Points to Watch from the Tree

Load Points from a List

Watch Or Graph Points

Select points to watch or graph by using the checkboxes in the tree.

Load Selection from list | ...zelect list... v

AHL List

Notes: Amazon REF Points

Disabled point names indicate points which anly have logs and cannet retrieve real time values.

List Power Buildsr




Now you have many points in your review area. Click Watch Points at the bottom right corner.

|| 75. BX2/Air Handlers (AHUs)/ NORTH DEH/Outputs/SPACE TEMP OUT
[#] 75. BX2/Air Handlers (AHUs)/ SALES/Outputs/SPACE TEMP OUT

|| 77. BX2/Air Handlers (AHUs)/ STOCKROOM/Outputs/SPACE TEMP OUT
I#| 78. BX2/Air Handlers (AHUs)/ BREAKROOM,Qutputs/SPACE TEMP OUT

Load Selection from list | AHU List A

Wiait several seconds for Connect+ to establish the real time communication to your controllers. You will see the value changes
from “?” to meaningful values.

F [ Creut= T5tandard] = | Site Diractories / Watch Or Graph Points
a0

S @ Inputs Watch Or Graph Points
[/]| .~ casE TEMR 1 " " " %
e T [TTy—y [EE—— [ ——
[ wesp crcurm ] 1. HVAC/LTS"/&ir Handlers (AHU=)/1-MAIN AHU/Inputs/COOL PROOF1 [ of
[ PRIDEMAND SHED [#l 2. RAK LT/TC"/Circuits {Standard)/Inpurs/CASE TEMP 1 EEG
[  SEC DEMAND SHEL 1#] 3. RAK LT/TC"/Circuies (Standard)/Inputs/CASE TEMP STPT -12.09F
[[]  START DEFROST ¥/ 4, RAK LT/TC™/Circuics (Standard)/Inpurs/CASE TEMP 1

© (@ Outputs ¥/ 5. RAK LT/TC"/Circuits (Standard)/Inputs/CASE TEMP STPT 0.00F

& B Params

& Srvema | Sovc s now it [[ERITSIR —

= Orozro L I ~—

= B) Inputs.
[l caseTEMR 1 Motes:
¥ caseTEmp sTET Disabled point names indicate points which only have logs and cannet retrieve real time values.
[ EMERGENCY OVR

List Power Builder

[ LEAD CIRCUIT
[[] PRI DEMAND SHED

6.2 What Else You Can Do With Points

In the Watch or Graph Points page, in addition to a watch points’ real value, you can also:

e Display Log Graph, Retrieve Logs, and Export for multiple points selected.

* Right-click on each point to access the Display Point Graph, Real Time Graph, and View Advisories.

Watch Or Graph Points

I#| 1. HVAC/Air Handlers (AHUs)/TT STORAGE/Outputs/SPACE TEMP OL'g

[+ 2. HVAC/Air Handlers (AHUs)/RECEPTION AREA/Outputs/SPACE TE} d
amae

I« 3, HVACSAir Handlers (AHUs)/REFG LAB/Outputs/SPACE TEMP OUT

Show on Real-time Graph
| 4, HVAC/Air Handlers (AHUs)/SIDNEY CONF RM/Outputs/SPACE TE!
Point Propartizs

LY

|# 5, PALO C¥=1/Air Handlers (AHUs)/AHU1 MzinSales/Outputs/SPACI

Connection Verification Report
[#| 6. PALO CX=1/8ir Handlers (AHU=)/RTUL Front End/Outputs/SPACE

Forward Advisories
|# 7. PALO C¥=1/Air Handlers (AHUs)/"RTU2 Officed/C"/Outputs/SPAC

Vigw Advizories
[

LY

| 8 HULarge/Air Handler_001/Outputs/SPACE TEMP OUT

|9, HVAC/LTS"/Air Handlers (AHUs)/1-MAIN AHU/Outputs/SPACE
| 10 HVAC/LTS"/&ir Handlers [AHUs)/GMI-SALES AREA/Outputs,
l# 11 HVAC/LTS"/Air Handlers [AHUS)/RTU-1 BAKERY,/Outputs,

[« 12 HVAC/LTS"/Air Handlers (AHUs)/RTU-2A PRODUCE Qutputs
l#| 13 HVAC/LTS"/Air Handlers (AHUs)/RTU-2B PRODUCE/Qutputs,

Create Setpoint Broadcast

Y

Configure Advisory Snooze
b

LY

Configure CB Maintenance
Configure Log Purge

Edit Application Instance
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6.2.1 Display Log Graph

We have introduced how to read log graphs in the Advisory View session. You can also Display Log Graphs from Watch Points.

* Toview an alarming point’s log graph, right-click on the point name and select Display Log Graph. The Log Graph you
displayed is the same as the one you shown in the Advisory View.

¢ To view multiple points log graph, click Display Log Graph and all selected points’ log graph will be shown for the same
time period.

12H 1D 2D 4D 1W 4w

- [ 0P ® S

On

T

Off

15:00 15:30 20000 20:20 21:00 21:20 22:00 22:20

—o [ 134 Adanta/1-MAIN AHU/COOL PROCFL

Highcharts.com

5

e S AN SN e N

=3
- B
-13
15:00 15:30 20:00 20:30 21:00 21:30 22:00 22:30
—- 154 Atlanta/CASE TEMP 1 —— 154 Atlants/ FD/CASE TEMP 1
“w- @ 134 Atlanta/CASE TEMP STPT —~ [ 134 Atlanta/ FD/CASE TEMP STPT (no log in controller)
Highcharts com

o

6.2.2 Retrieve Logs

If the points you selected do not have logs retrieved, you might want to click the Retrieve Logs + Graph button or from the
graph click the menu and the click the Refresh icon (shown as two arrows in a circle). When you Retrieve Logs, Connect+ will

display the Activity progress.

Retrieve Logs From List
In Progress 62%

Target : Directory Multiple
Started 4/25/20 10:533 PM
Duration 2 s=conds
StartMethod On Demand

User

Hide Details

(Calculating Execution Data...
Processing 3 points...

Done processing points,
Starting on Directory Demo

20




Once completed, you can go to B Header Menu > Activities > View My Activity History to check the Retrieve Logs status.

My Activity History - Results

Ocourrence Date |Past 7 Days v Show([25 ¥

@ Retrieve Logs From List 4/25/20 B:25FM 00:00:03 Multiple s Completed

@ Retrieve Logs From List 4/25/20 B:24 PM 00:00:02 Multiple 4 Completsd

6.2.3 Export

To export log data for these points, click Export and enter the time range. Click Go to start the export. Once completed, an
excel file will download to your computer.

Display Log Graph Retrieve Logs + Graph Retrieve Logs Retrieve Logs + Export m

From [2020-04-24 00:00:00 | [ To[2020-04-26 23:59:59 |[@ Time Perspective: File Type: [Comprehensive ¥ |
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7 Global Search

A search can be performed by entering criteria into the
search field on the Connect+ header. You can search for
a Site’s Home Screen, or for a specific Directory, Sites,
Controller, Devices or Points.

o eaioe o
o fiw  UTAm

Icon Key
®  voma remgeraton
@ oo

@ wm

3¢ = ooer [ Q. ©

When a site is configured with a Site Home Screen, you can
search the Home Screen by entering the site name.

To go directly to a Site’s Home screen, click in the search bar
and select the Site Home Screen Name from the drop-down
menu.

If you click the search button, it will perform a normal search and returns all related results.

Search Resules Relevance I (0.0 0%

MNams Type iContext

Condensers Application Type = Demo > 162 = E2 = RX-400 4: LT DESK > Condensers
Condensers Application Type > A _Kennesaw TechSupport > 55 > E2 = RE-400 2: E2 Unit2 > Condensars
Condenzers Application Type > H > 00238 = E2 » RX-300 1: RACK A > Condensars
Condenzers Application Type = H > 00238 > E2 = R¥-200 2: RACK B > Condensers
Condensers Application Type = H > 00238 > E2 > R¥-300 3: RACK C > Condensars
Condenzers Application Type = Demo > 154 Atlanta = E2 > R¥-400 3: PROTD A/B > Condensers
Condensers Application Type = Demo > 134 Atlanta = E2 > R¥-400 2: RAK LT/TC > Condensers
Condenzers Application Type > M > MO0296 = E2 > R¥-400 2: RACK 1 = Condensers
Condenszers Application Type = M > M00256 = E2 > RX-400 3: RACK 2 > Condensers
Condensers Application Type > M > MO0296 = E2 > RX-400 4: RACK 3 = Condensers
Condenzers Application Type > M > MOO2%E > E2 > R¥-400 5: RACK 4 > Condensers
Condenzers Application Type =M = MO02%6 = E2 = R¥-400 6: RACK 5 > Condensers
Condensers Application Type > M » MOO2%E > E2 > R¥-400 7: UNIT § > Condensers
Condenzers Application Type = M = MO0120 = E2 > RX-400 1: RACK 182 = Condsnsers
Condensers Application Type > M = M00120 = E2 = RX-400 2: RACK 284 > Condenzers
Condznsers Application Type =M > MO0120 > E2 > RX-400 3: RACK 5 = Condensers
Condensers Application Type = R¥400-Refrig:LT DESK * Condensers

Condensers Application Type > Test > Fan Test » RX-400 2: RAK LT/TC > Condensers
Condenzers Application Type > Test > Fan Test > RX-400 3: PROTO A/B = Condensers
Condenzers Application Type = Test = Fan Test > R¥-300 4: E2 UnitD4 = Condensers
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8 View Enterprise Summary

The View Enterprise Summary located in the Toolbar Menu displays the overall understanding of your Enterprise Assets such as:

e How many stores do | have?

e How many controllers do | have?

¢ How many are building control

e How many are Ref Controllers?

e How many are E2 and how many are Site Supervisor?

¢ How many Case Controllers do

lers?

| have?

e How many Roof Top Units do | have?

EMERSON

Helle Fan

You can view Enterprise Summary from Directory to Application Instance. Each contains different information.

Enterprise Summary
@ @ @ @ @
Centrol System w Model a2nd Series -
. 4| sort Ascending ALL —
XWES name Demo HwehEVD V.STANDARD 7 Z] SortDescending Unknown 4
EMERSON TEST Demo 54 Charlotte Kweb500 2.2.1_065 Ver:2.0.0 Unknown 4
Xweb5000EVO Demo XWEB EVO Fiera V.STANDARD 12 Columns P | @ Unic
Jenny9 Demo EVO Dev Hineb EVO V.STANDARD 10 br2014.08 [#] Directory
Jenny9 Demo HwebEVD b EVO V.STANDARD 10 br-2014.08 @ see
US_1001_L Bon A L 1001 Hweh EVO vii br-2014.08
[#] Contraol System
US_1003_L_Newport.. L 1003 Xuwieb EVO w11 br-2014.08
US_1006_L_Suffolk_. L 1006 Xweb EVO Vi1 br-2014.08 La| e GRS
Lebss 152 Bzhama Site Test [=3 214807 [ Coneraller Version
E2 Unit02 Demo 100 Kennesaw TechSupport RX-400 <.08F04 [¥] Gateway
55 Unit01 Supervisor New Site sup RXe 2.07F01 Menitoring Master
SUITE 170 Demo 100 Kennesaw Suite 100 BX-300 <.10F01
Annundiator
HVAC Demo 100 Kennesaw Suite 100 BX-400 4.09883
Rack A Dems 250 Wake Forrest S Peer cxe 2.12836 o] el B G
7 [@] Mumber of Backups Implemented
) Lo Bacup Time

MEooowWwooooooooo

o2 ¥

03/19/20 07:46 AM

05/11/18 10:23 PM -

As with Advisory View, you can sort, filter, and add more columns for your review. You can also export to Excel, PDF, or HTML

files.
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Appendix A: Summary of Export Capability
e | amearge | Uk

Advisories Advisory View Toolbar Menu & Tree
Live Advisories Live Advisory Control System
Watch Points Watch Point Page
Log Data Advisories View > Log Graph > Setting

Log Graph Watch Points > Log Graph > Setting
Graphical Screens > Log Graph > Setting

Connection Verification Report Site not Sending Alarms Toolbar Menu

Enterprise Summary Enterprise Summary Toolbar Menu

Appendix B: System Summary Screens
System Summary Screen Ul Access Level

Refrigerant Summary Site

Building Summary Site

Other Summary Site

Summary (Controller) Unit

Summary (Application) Application Type
Defrost Summary Application Type
Graphical Status Application Instance
Status Application Instance

24



Site Level: Refrigeration Summary

Refrigeration Summary

No application instances of this type

RX-400 2: RAK LT/TC RACK LT 17.0 PSI 15.0 PSI o 4
RG-A00 2: RAK LT/TC RACK TC 20.0 PST 15.0 PSI SUCT MON TEMP 2
RX-40@ 3: PROTO A/B PROTOCOL A 54.0 P51 50.0 PSI &
RX-A00 3: PROTO A/B FROTOCOL B 63.6 PSI 54.0 PSI s = Owerride 6

Display Log Graph
Graph Collection b

Show on Real-time Gragh

RX-300 4: E2 Unitdd CONDENSER NOWE PSI  200.0 PS! 77
RX-400 2: RAK LT/TC CONDENSER LT 2162751 210075 Doint Properties ??
RX-400 2: RAK LT/TC CONDENSER TC 1724 PSI  180.0 PS] 77
RX-400 3: PROTO AE CONDENSER A 77 77 Connection Verificstion Report ??
RX-400 3: PROTO A/B CONDENSER B 1S0.0 PSI  222.0 PS] ??

Forward Advisories

Vigw Advisories

Create Setpoint Broadcast

u Circuit (CC Alarm State .
Mo application instances of this type Configure Advisery Snooze .

Configure CB Maintenance
Configure Log Purge
T .

dxdddd

Edit Application Instance

R¥-4DD 2: RAK LT/TC LTEA DT MEAT =
R¥-ADD0 2: RAK LT/TC LTEBE DT MEAT =
R¥-4D0 2: RAK LT/TC LTEC DT MEAT =
R¥-4D0 2: RAK LT/TC LTS SEAFD FRZR =
R¥-ADD 2: RAK LT/TC MEAT FREP 30 .

Total Stages 3
100.0 % OK
100.0 % OK
100.0 % OK
50.0 % oK

Fan{s} On
Fanis} On
Fan{s} On
Fanis} OIT
Fan{s} OIT

stp
REFRIGERATIOM -2.3 9F -12.0 OF
REFRIGERATIOM -1.4 9F 0.0 oF
REFRIGERATION 0.0 @F 0.0 oF
REFRIGERATIOM -2.2 9F 0.0 oF
REFRIGERATION -1.7 oF 0.0 OF
REFRIGERATIOM 1.0 oF 0.0 oF
REFRIGERATION -0.5 9F 0.0 OF
REFRIGERATIOM -1.6 9F -1.0 9F
REFRIGERATION 0.1 °F 0.0 OF
REFRIGERATIOM 25.0 ©F 28.0 °F
REFRIGERATION -7.5 9F 0.0 OF
REFRIGERATION 42.7 ©F 50.0 °F

-

Site Level: Building Summary

/Demo/154 Atlanta

Building Summary

NONEJRIS

NOME RH NOME Fic
RX-400 2: RAK LT/TC °F RH NOME RH Fic
RX-400 3: PROTO A/B L7 RH NOMNE RH Fte
Unit AHU Temp Setp Status Occupied
BX-400 1: HYAC/LTS 1-MAIN AHU NOME =F NONE °F Mo Ctrl UNROCC
AHUL NOME &F HONE °F No Ctrl UROCC
GMI-SALES AREA NOME ©F NONE °F Mo Cirl UNOCC
RTU-1 BAKERY NOME °F NOMNE °F Mo Ctrl UNOCC
RTU-24 PRODUCE NOME ©F NONE °F Mo Cirl UNOCC
RTU-2B PRODUCE NOME °F NONE °F Mo Ctrl UNOCC
RTU-3 KITCHEN NOME ©F NONE °F Mo Ctrl UNOCC
BX-400 1: HVAC/LTS RTU-4 CONF RM NOME =F NONE °F Mo Ctrl UROCC
Unit___ARTC o Bl Unit  Lighting (ENH) Output] Unit
Mo application instances of this type EX-400 1: HVAC/LTS OUTSIDE LIGHTS an BEX-400 1: HVAC/LTS
BX-400 1: HVAC/LTS PARKING LOT an BX-400 1: HVAC/ILTS
BX-400 1: HVAC/LTS SALES LIGHTS On BX-400 1: HVAC/LTS
BX-400 1: HVAC/LTS STOCK LIGHTS arr BX-400 1: HVAC/LTS
BX-400 1: HVAC/LTS
BX-400 1: HVAC/LTS
BX-400 1: HVAC/LTS

m Refrigeration Summary | Other Summary

Schedule Dutp
10101 na
MAIN QCCUPANCY O
RTU-1 DOUPANCY na
RTU-2A OCUPHCY an
RTU-2E OCUPNCY an
RTU-3 OOUPANCY an
RTU-4 DOUPANCY an
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Site Level: Other Summary

Other Summary

Unik

R¥-400 2: RAK LT/TC
RX-400 2: RAK LT/TC
Re-400 2: RAK LT/TC

niro

Anti-Sweat nt
ANTI-SWEATO1 HNOME °F 0.0
ANTI-SWEATD2 NONE °oF 0.0
ANTI-SWEATOZ HNOME °F 0.0

Unit Power Channel KW Avg KW Shed Time in Shed

Demand Co
No application instances of this bype

BX-400 1:
HVAC/LTS MAIM POAWER MON 0.0 KW 0.0 KW RESTORED
Unit Analog Sensor Value Command N Unit Digital Sensor Cirl Value Command N
BX-400 1: HVAC/LTS COMPRESOR ROOM HOME &F ar EX-400 1: HVAC/LTS Load arr ar
BX-400 1: COMPUTER ROOM NONE °oF arr . ] 12VDC PWR RX #2 o
BEX-400 PHARMALCY TEMP HOME &F ar ALARM DISABLE na arr
RX-400 2: RAK LT/TC AMBE TMP SEL LT NONE °oF arr RX-400 2: RAK LT/TC ATC BYPASS LT o o
R¥-400 2: RAK LT/TC AME TMP SELTC S0.0 °F ar A¥-400 2: RAK LT/TC ATC BYPASS TC arr arr
RX-400 AMBE TMPCALC LT 90.0 °F arr RX-400 2: ATC CONTROL LT o on
RX-400 AME TMPCALZ TC HOME &F ar AX-400 ATC CONTROL TC arr on
RX-400 2: RAK LT/TC DIS TEMP RK LT NONE °oF arr RX-400 2: RAK LT/TC MTPREP RUN PRF o m
R¥-400 2: RAK LT/TC DIS TEMP RK TC HOME &F ar A¥-400 3: PROTO A/B ALARM DISABLE na arr
RX-400 2: RAK LT/TC DISCH TEMP LT NONE °oF on - RX-400 3: PROTO ASB ATC CONTROL A o on -
m m Refrigeration Summary Building Summary
.
Controller Unit Level: Controller Summary
Building Controller Summary
Controller Summary
AHU Temp Setp Status Occupied
1-MAIN AHU NONE °F NONE Mo Curl UNOCC
AHUL NONE °F NONE No Curl UNOCC
AREA NONE °F NONE Mo Curl UNOCC
RTU-1 BAKERY NONE °F NONE Mo Curl UNOCC
RTU-2A PRODUCE NONE °F NONE Mo Curl UNOCC
RTU-2B PRODUCE NONE °F NONE Mo Curl UNOCC
RTU-3 KITCHEN NONE °F NONE Mo Curl UNOCC
RTU-4 CONF BRM NONE °F NONE Mo Curl UNOCC
ARTC Docup ghting tp Schedule Duiput
No application instances of this type OUTSIDE LIGHTS On 10101 na
PARKING LOT Oon MAIN OCCUPANCY ofr
SALES LIGHTS On RTU-1 OCUPANCY na
STOCK LIGHTS arr RTU-2A OCUPNCY Oon
RTU-28 OCUPNCY Oon
RTU-3 OCUPANCY Oon
RTU-4 OCUPANCY Oon
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Ref Controller Summary

Controller Summary
Suct SP
Ho application instances of this bype
T .
RACH LT 17.0 PRI 15.0 PSI 4 4 100.0 % OK
RACK TC 20.0 PST 15.0 PSI 2 i 100.0 % oK
Condenser P Ctrl P Sed T Cird T Setpt V5 RPM V5 State
CONDENSER LT 211.3 PSl 210.0 P51 77 7 77 7 Fanis) On
CONDENSER TC 171.5 PSI 180.0 PSI ?? ?? ?? ?? Fanig) On
Circuit (CC Alarm Siate Temp sitpt Circuit (Standard Alarm State Temp Setp ~
No application instances of this by pe GROC = REFRIGERATION -5.39F -12.0°F
FROZ FD = REFRIGERATION 0.3 °F 0.0 °F
FROZ FD s REFRIGERATION 1.30F 0.0 oF
FROZ FD - REFRIGERATION 0.2 oF 0.0 oF
FROZ FD = REFRIGERATION -1.49F 0.0°%F
FROZ MT - REFRIGERATION 0.2 °F 0.0 °F
FROZ FD s REFRIGERATION -0.39F 0.0 oF
DT MEAT o REFRIGERATION -0.F9F  -1.09F
DT MEAT = REFRIGERATION -1.79F 0.0°F
DT MEAT = REFRIGERATION 22.0°F 28.0°F
FRZR s REFRIGERATION -7.59F 0.0 oF
MEAT FRE® 30 o REFRIGERATION 50.1 ®F 50.0 °F A
Application Type Level: Summary Screens
Circuits (Standard)
m
Name State Temp Alarm Refr
GROC REFRIGERATION -8.3 °F s on o
RI FROZ FD REFRIGERATION -0.6 oF s off o
RI FROZ FD REFRIGERATION 1.4 oF s off o
RI FROZ FD REFRIGERATION -2.8 °F s o o
RI FROZ FD REFRIGERATION -0.9 °F s ofr o
MD FROZ MT REFRIGERATION 1.0 oF = off o
RI FROZ FD REFRIGERATION -1.8 oF s off o
MEAT REFRIGERATION -2.2 °F = o o
MEAT REFRIGERATION 1.7 °F s on o
MEAT REFRIGERATION 27.1 9F s off o
FRZR REFRIGERATION -7.5 O0F = On o
MEAT PREP 3D REFRIGERATION 47.0 9F s o o
SRVC FISH REFRIGERATION -3.5 °F - on o
RI [CREAM REFRIGERATION -5.30F as on ofr
RI [CREAM REFRIGERATION -1.7 oF as On ofr
RI FRZ FD REFRIGERATION -0.2 °F s on o
FRZ SEAFD REFRIGERATION -1.6 °F s on (51
Defrost Summary
Circuit  Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Max
e 1 2 3 4 5 6 7 & © 10 11 12 13 14 15 16 17 ) 9 20 21 22 23 24 Time
cRoc 030 B30 w80 R 2772 s 0 0 0 : : 0 0 0 0 : 0 0 0 0 o7 GAE 0035
gRiZ w00 ? 7 ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? HOT GAS 0:20
s PO T T S T TR S B R ? ? ? ? ? ? ? ? ? ? ? ? ? ? HOT GAS 0:20
oz 20 7 o o ot o 7 1 % ® ® ® ® ® ® ® ® ® ® ® ® ® ® HOT GAS 0:20
ESOZ 2:30 6:00 14:30 20:30 7 7 7 7 7 7 7 7 7 7 7 7 7 7 7 7 7 7 7 7 HOT GAS 0:20
p=e 3:00 ®:00 1500 20007 0F 0?7 P 7 ® ® ® ® ® ® ® ® ® ® ® ® ® ® HOT GAS 0:20
ESOZ 3:30 7 ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? HOT GAS 0:20
MERT PHETR IR T T T T S A : : : : : : : : : : : : : : HOT GAS D:20
MEAT T ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? HOT GAS 0:20
MEAT ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? HOT GAS 0:20
FSRE;FED 4:30 10:30 16:30 22:30 7 ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? HOT GAS 0:25
. OFF .
MEAT PREPIDZ:OO T 0?7 7 F P P % 7% ] ] ] ] ] ] ] ] ] ] : : : : e 200
SRVC
i FERETR I T T N I : : : : : : : : : : ] ] ] ] HOT GAS D:18
EREAH 5:30 17:30 7 ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? HOT GAS 0:22
RI
= (R T T N L : : : : : : : : : : ] ] ] ] HOT GAS D:22
:IDFRZ 3:00 15:00 7 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T HOT GAS 0:20
FRZ
I 100 7:00 13:00 19:00 7 + + + + + + + + + + + + + + + + + + + HOT GAS 0:18




Application Instance Level: Status Screen & Graphical Status

28

Status: REFRIGERATION

Contral Temp ' -8,3 OF
Case Temp Setpoint -12.0 oF
Term Type TIME

1 BN

Refrigeration on
Defrost Off
Fan On
LLS IMNACTW
Clean Switch MONE
/Demo/154 Atlanta/E2/"RX-400 2: RAK LT/TC"/Circuits (Standard)/LT1 GROC
Standard Circuits Status
EMERGEMNCY OVR na Term Type TIME CIRCUIT STATE REFRIGERATION
CASETEMP 1 oF CASE TEMP STPT -12.0 oF REFRIG SOLENOID on
CONTROL TEMP -9.3 oF CASE ALM HI SP 41.0 °F DEFROST Off
CASE ALM LO SP -15.0 oF PEAK DEF TEMP 56.2 °F
COMB ALM HI 5P NONE ©F FAN on
COMB ALM LO SP MNONE °F BYPASS STATE MNORMAL
ACTIVE SETPT -12.0 °F ALARM OUT o=

ALG STATUS OK
CASE ALMOUT 1 oo
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